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1:  Chester & Flintshire Talking Newspapers

1: Chester & Flintshire Talking Newspapers

Chester Talking Newspaper, a registered charity, has its own recording studio located in Chester 
city centre. Established since 1977, we have been recording and distributing hundreds of audio 
cassette tapes every week, to the visually impaired in Chester and Flintshire.

Our studio is now equipped to enable us to record and copy digitally, and this has proved to 
greatly enhance the efficiency of our operation.

In preparation for when cassette tapes are no longer available we now aim to deliver a fully 
digital product to our Service Users using memory sticks. These devices allow us to offer a 
higher quality service without the restrictions and limitations of audio cassettes, allowing us to 
offer increased content, and allowing listeners to quickly navigate to the content they wish to 
hear.

Currently our Chester edition is in the process of "going digital", and we hope to start offering the 
Flintshire edition in a digital format soon.

The aim of this manual is to give all volunteers an insight and grounding into the aspects of 
digital recording that will be most useful for the successful changeover and implementation of the
new systems.

This manual is available in hard copy for each recording team, on the recording computer in the 
studio, and on our website at www.chestervip.org.uk
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Please Note:

Whether you record the News or Magazine, please read the 
whole Manual



2:  Adobe® Audition® 2.0 – General Instructions

2: Adobe® Audition® 2.0 – General Instructions

2.1 General Information.

Refer to 4 - Post-recording processing, as required.

2.2 Digital Recording Procedure

Start the computer and, from the Desktop, open up Adobe® Audition® by double-clicking on the 
desktop icon. 

Click on File, then New to start a new recording, the following options will  appear:

Ensure the Sample Rate is set to 44100

Select Mono

Set Resolution to 16-Bit

Click on OK

A blank recording screen will show.

You are now almost ready to start the full recording, but first start to record (by pressing Ctrl+ 
Space) until the vertical cursor line has passed about three-quarters way across the screen, then
stop the recording process (by pressing the Space bar). With the mouse, left-click on the Skip 
Back button in the Transport Field, or press the Home key on the keyboard,, to return the cursor 
to the start point. (This has the effect of showing a more easily viewed waveform on the screen 
as recording progresses).

Next you need to save your blank file:

Click on File, then on Save As. When the drop-down menu shows, ensure that you select the 
correct folder from the D:\ (Audio) drive.

Click on Save.

Ensure that the file is saved in the correct format type, i.e. Windows PCM (*.wav). And with the 
correct filename. (See section 4.2 - Saving digital recordings for file names and folders)
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2:  Adobe® Audition® 2.0 – General Instructions

With the cursor at the left-hand of the screen, you are now ready to start recording.

NB. The News recordings MUST be longer than the Magazine recording by at least 10 to 20 
seconds. This is a requirement for the files input to the EDAT system.

2.3 Transport Controls

 In the above image, the controls are (left to right, top row first):

• Stop (Spacebar) 

• Play (Spacebar). This will stop at the end of the screen or highlighted section 

• Pause while recording (Ctrl+Spacebar) 

• Play to end. This will play through to the end of the recording. 

• Loop. This plays the selected section repeatedly. 

• Skip Back. This takes you to the previous cue marker, or the start of the recording if 
no markers before the current position. 

• Rewind. Click and hold to rewind. 

• Fast Forward. Click and hold to fast forward. 

• Skip Forward. This takes you to the next cue marker, or the end of the recording if no 
markers after the current position. 

• Record (Ctrl+Spacebar) 

2.4 Generic Recording Screens

The bar above the waveform represents the entire recording. The Green Section of the bar 
represents the section visible on screen. This can be grabbed and moved backwards and 
forwards to navigate your way around the recording. The side edges of the bar can also be 
dragged to increase or decrease the amount of the recording visible on screen.
Once stopped, any section of the recording can be highlighted for editing by clicking and 
dragging over the waveform. Common editing controls include:

• Delete key to delete the highlighted section 

• Ctrl+C to copy section 
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2:  Adobe® Audition® 2.0 – General Instructions

• Ctrl+X to cut section 

• Ctrl+V to paste a copied or cut section in 

• Ctrl+A to select the entire waveform 

• Ctrl+Z to undo the last edit 

• F8 to insert a marker 

While recording use the white bars at the top and bottom of the waveform to help set the correct 
recording level. Aim to set the peak recording level between -3 and -1dB.

2.5 Timing information
Two windows below the main waveform give information about the recording time

The main time window shows the time at the current cursor position. Whilst recording, this will be
the total record time. In editing, this time will show the start of any selected section of the 
waveform.

The additional time window shows two rows of information. The top row shows times for the 
current selection’s start point, end point and length, whilst the bottom row shows the same times 
for the current view.
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2:  Adobe® Audition® 2.0 – General Instructions

Whilst editing, you can click in any of these time boxes to enter an exact time you wish to move 
to, or select.

2.6 Generic Saving Screen

More detailed and specific screens relating to recording or processing of Magazine or News files 
follow in this Section. See Section 3 for details of editing the Magazine.

Select correct location in Save In field

Ensure Save as type shows Windows PCM (*.wav)

Give the file an appropriate name in the File Name field.

Click on Save 

(See 4.2 - Saving digital recordings for folders and file names to use)

Please remember that we are developing our knowledge base of this system as we go along, 
and processes may vary with time. 

CTN & FTN Operating Manual 7



3:  Adobe Audition - Magazine Specific

3: Adobe Audition - Magazine Specific

If not recording opening music from CD, it may be put at the start of the file by placing the cursor 
line (a full triangle at top and bottom) at the extreme left of the recording window, then following 
the instructions as for Mix Paste below:  

3.1 To Insert a file or CD track using Mix Paste.

With cursor line at the point required in the recording window, select Mix-Paste, from the Edit 
menu.

Click on Select File, with Volume as highlighted (100%)..

Select the required file from the Resources folder, or CD track as shown in the following
screen. Click on Open, then click on OK in the Mix Paste window to insert the file.

The required file will now be positioned in the recording window. Move the cursor to the right-
hand end of the waveform in readiness to continue recording, as shown in the following screen.
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3:  Adobe Audition - Magazine Specific

As recording progresses it is considered prudent to save the Magazine file at any convenient point 
when recording is temporarily stopped. Select File, then Save.

Now go to Section 4 - Post-recording processing before final saving.

3.2 Deleting selected sections of recordings

Place the cursor at the start point of the section requiring to be deleted, and drag to the finish point, 
then release. The section to be deleted will be highlighted as shown:

On the computer keyboard, press Delete. The selected portion will be removed. If you require to 
reinstate the selection, go immediately to Edit, and click on Undo delete.

3.3 Increase/decrease volume level to selection

From the Effects menu select Amplitude, then Amplify:
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3:  Adobe Audition - Magazine Specific

Using the drop-down Effect Preset menu, select the amount of reduction or increase 
required and click OK.

As with most Windows operations, to reverse the selection, select Undo from the Edit menu.

NB Go to Section 4 - Post-recording processing before final saving.

3.4 Magazine Recording Technicians only: 

Please ensure that the 1Gb memory stick has been erased before attempting to transfer files, 
since each WAV file will be in excess of 200Mb in size.
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4:  Post-recording processing

4: Post-recording processing

After recording and any required editing, the waveform will look like this:

Click on Effects button, Amplitude, and Hard Limiting (Process):

After processing, the screen will look something like this:

Save the file once processing is complete.
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Set Limit Max Amplitude to -3dB

and Boost Input by 3dB

click OK



4:  Post-recording processing

4.1 Create a copy of the wave file for cassette duplication

Insert the 1-Gigabyte memory stick in the computer’s front USB port. In the appropriate folder on
the D:\ (Audio) drive, right-click on the newly recorded file. When the drop-down menu shows, 
click on Send to, and then select UDISK. Remove the Flash memory only when the led has 
stopped flashing.

The 1 Gigabyte flash memory may now be used to transfer the files to the EDAT™ computer for 
cassette copying.

4.2 Saving digital recordings

Throughout the year, using Week numbers 01 to 52, as appropriate

Files are identified and saved in the appropriate folder on the D:\ (Audio) drive as:

Publication Folder File Name Example

Chester News Chester CNewsWeekNN.wav CnewsWeek30.wav

Flintshire News Flintshire FNewsWeekNN.wav NewsWeek30.wav

Magazine Magazine MagWeekNN.wav MagWeek30.wav

When files are transferred to the EDAT™ computer to generate the master copying file, the file 
names should be as follows.

Chester ChesterWeekNN.mst ChesterWeek30.mst

Flintshire FlintWeekNN.mst FlintWeek30.mst

Magazine (only) MagWeekNN.mst MagWeek30.mst

4.3 Housekeeping

As the year progresses, it is intended to 'clear down' and archive files as necessary to ensure 
that the computer function is not impaired.
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4:  Post-recording processing

NOTE: To process files for copying to memory sticks, please see Section 6 -
Converting WAV files to MP3.
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5:  Telex EDAT ™digital recording to Compact Cassette tapes 

5: Telex EDAT ™digital recording to Compact Cassette tapes 

Place the memory stick containing the wav files into the computer’s USB port.

 This is the Telex EDAT™ opening screen, after double-clicking the EDAT™ icon. Click on 
Duplicate to open next screen.

Click on Create New Master.

Name the new master file using the appropriate name (See 4.2 - Saving digital recordings for 
file names to use). Click on Create.
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5:  Telex EDAT ™digital recording to Compact Cassette tapes 

In the Directories section, click on E: (which is the memory stick), the file(s) will now show in the
Wave Files field. With the Master Tape field set to Side A (box yellow), click and drag the 
required news file to the Master Files field.

Select Side B in the Master Tape field, and drag the magazine wav file to the Master Files field.

Click on Create.

Once the master file has been successfully created, the mastering window will show:

Load all of the cassette positions with erased and fully rewound cassettes.

Using the radio buttons, select Auto, then click on the Record button to create the new 
cassettes for distribution.
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5:  Telex EDAT ™digital recording to Compact Cassette tapes 

If any cassettes have not copied properly, erase them, and repeat the recording process. (You 
should not need to re-create the master file).

Once the cassettes have all completed copying, close EDAT, shut down the computer, and turn 
off the power to the cassette decks.

If all cassette positions are not fully occupied and copying does not start, physically stop any 
rotating reel spindles with the fingers. The system will then start to copy.
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6:  Converting WAV files to MP3

6: Converting WAV files to MP3

Minimize Adobe Audition 2.0 and open the output folder in Windows Explorer. Once open delete 
all previous weeks files (for example if this week's files are MagWeek1701.mp3 etc., delete all 
files starting MagWeek16)

6.1 Tracking & converting to MP3

Introduction

To enable listeners to have some directional control over the operation of the USB loudspeakers 
i.e. as if they wished to fast-forward or review a part of the recording, as they are able with 
compact cassette, it is necessary to split the recording into a number of tracks. The listener then 
has only to use the track reverse button to hear an item again without going back to the start of 
the recording. 
There are two methods by which markers can be inserted into a waveform, either "on the fly" 
whilst recording, or in post-processing. Inserting markers after recording (post-processing) allows
for more accurate placement, but takes time to find the correct positions to place the markers, 
whilst inserting when making the recording can sometimes leave markers a little out of place.

A marker should always be placed at the very start and the very end of the recording. Do
this by pressing the F8 key before starting recording, and pressing it again as soon as 
the recording has been stopped.

Whilst Recording

To insert a marker while the recording is taking place, simply press the F8 key on the keyboard. 
This should be done as a minimum every time the reader changes. If the marker is not in quite 
the right position, it can always be adjusted once the recording is complete.

Post-Processing

Move the cursor to appropriate positions on the waveform, in turn, designating natural track 
breaks, i.e. usually where there is an item change in the programme. This may require reference 
to timing notes made earlier, and/or listening to the item to place the marker accurately at the 
appropriate point.

Use the mouse to select the point on the waveform where you wish to insert a marker, and press 
F8. Use the mouse-wheel or zoom controls to zoom into the waveform at the insertion point to 
position the marker accurately.
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6:  Converting WAV files to MP3

The screen shot above shows a recording with basic markers in position:

You can adjust the position of the markers by clicking and dragging on the small triangle at the 
top or bottom of each marker.

Once all markers have been inserted, they need to be converted to range markers in order to 
create the MP3 tracks.

Press Alt+8 to open the Cue List. This is a list of all the markers which have been created, 
showing the time point where they have been inserted.

Click on the first marker, then holding down the shift key, click on the last marker. This will select
all of the makers.

Click on the Merge Markers button to convert all of the markers to ranges, ready for processing 
to MP3 files.

Click on the Batch Process button to create the MP3 files

Select the following options in the Batch Processing window before clicking on OK
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6:  Converting WAV files to MP3

➢ Select the Save to Files option 

➢ Ensure that Use marker label as file name is not selected. 

➢ Enter appropriate text in the Filename Prefix box - this should match the wav 
filename. 

➢ Check the correct destination folder is selected: 

 Magazine: D:\Magazine Tracking Folder 

 Chester News: D:\Chester News MP3 

 Flintshire News: D:\Flintshire News MP3 

➢ Ensure that Output Format is set to mp3PRO® (FhG) (*.mp3) 

➢ Click on the Options button, and check that the recording is set at 32kbps, 24000Hz, 
Mono (22.1:1)

Click on OK to confirm the save options, then click OK in the Batch Process window. This will 
save each marker as a separate track in the selected folder.

Close or minimize Adobe Audition 2.0 and open the selected folder in Windows Explorer. Once 
open delete all previous weeks files (for example if this week's files are MagWeek1701.mp3 etc.,
delete all files starting MagWeek16)
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7:  Website uploads

7: Website uploads

7.1 Saving for the website
Once the copies for cassette and memory stick have been created, a copy of the full recording 
must be created in MP3 format for the website.  This copy includes some basic text information 
about the recording, which will be automatically included on the Listen Now page of the website.

From the File menu, select File Info... which will open a dialogue box.

In the Comments section, enter details of the main articles in the recording. Three or four article 
headlines are usually sufficient.

There is no need to add introductory text (eg “In this week's edition”), as this is 
automatically added when the file is uploaded to the website.

Click on OK, then go to File and Save As.  Select your memory stick as the file location, and 
ensure that Output Format is set to mp3PRO® (FhG) (*.mp3) then click on Save.

7.2 Uploading to the website

CTN does not have any internet access at the studios. Uploads to the site need to be 
done from home.  If you do not have broadband internet access, in the first instance 
please see if another member of your team can do the upload. If this is not possible, 
send the prepared MP3 on a memory stick to the IT manager for upload using a pouch. 
This should be an option of last resort!

Your memory stick should have a copy of CTNUploader.exe on it. This is our custom program 
for transferring recordings to the website.  This should run on any modern PC (XP or newer). If it 
does not run, use Windows Update to ensure that your .NET framework is up to date (at least 
Version 4.5)

Use the dropdown box at the top to select the edition you are uploading (Chester, Flintshire, 
Magazine or Extra), then click on the Browse button (…) to select your saved MP3 file and 
finally click on Start Upload to transfer to the website. A progress bar will show the upload – be 
patient, it will probably take at least 30 seconds to upload on an average broadband connection.

The program will automatically rename your selected file for use on the website.
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8:  CTN Master Disk Builder

8: CTN Master Disk Builder
The master disk builder programme is used to generate the master copies of the memory sticks, 
ready for duplication. It automatically reads saved MP3 files from the recording session, and 
copies them in the correct order to the master disks.

8.1 Starting CTN Master Disk Builder
CTN Master Disk Builder can be started by double clicking on it’s icon on the computer desktop.

8.2 Selecting Publication
Use the publication drop-down to select between Chester and Flintshire editions of the 
newspaper. Each edition has it’s own independent set of folders to copy from.

8.3 Input folders
With the correction publication selected, the currently set folders will be displayed. Each line in 
the display shows information for a different folder.

Lines written in black text, with a green dot at the start, are enabled and will be copied as part of 
the build progress.

Lines written in grey text, with a red dot at the start, have been disabled, and will not be copied. 
To enable or disable a folder, click on the line for that folder, then select “Enable” or “Disable” 
from the Folders menu.

Check that the standard folders (News and Magazine) are showing, in the correct order
and enabled (showing a green dot) before continuing. If extra folders have been left in
from a previous week, Disable or Remove them before building the master disk, or the

files in those folders will be included on your disk as well!

8.4 Setting the copy order for folders
The folders will be copied in the order they appear in the list. In the above image, the News 
folder will be copied first, followed by the Magazine folder.
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8:  CTN Master Disk Builder

To change the copy order, select the folder you wish to move, then use the Move Up or Move 
Down options on the Folders menu.

8.5 Adding (or editing) extra folders to copy
Additional folders can be copied as part of the build process. From the Folders menu, select the 
Add option (or press Ctrl+D). You will see the following screen:

Use the drop down list to select a folder type. This is purely for reference to help identify folders. 
You are not restricted to the entries in the list, and can type anything in this box.

Click in the Folder Location box, which will automatically open the Browse for Folder window:

Select the folder you wish to copy files from, and click on OK. When editing an existing folder, 
the browser will initially select the existing folder.

Finally, enter a suffix (max four letters) to use when renaming files to build the master disk. 
Ideally, each folder should have it’s own suffix so that the build process can be quickly verified. 
News folders should have the suffix “news”, while Magazine folders should have the suffix “mag”.

Clicking on OK will add the selected folder to the Input folders list.

8.6 Building master disks
Insert memory sticks into the USB ports on the computer tower. As you insert the memory sticks,
they will appear in the Output Drives list.
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8:  CTN Master Disk Builder

Select the disk drives you wish to write the master copies to by clicking on the check-box next to 
the drive name. Normally you will be able to use the Drives menu, and click on the select all 
option to choose all memory sticks. 

Warning all USB memory sticks plugged into the computer will have their data erased,
and be re-formatted with the current weeks news and magazine. Ensure any data or
personal memory sticks are removed from the computer before using the “Select All”

option.

Once all the drives have been inserted and selected, click on the Build button to start copying the
MP3 files to memory stick.

If a selected folder does not contain any MP3 files, you will receive a warning telling you which 
folder(s) had a problem:

You will then be given the option to continue, or cancel the build process.

If there were no problems, or you choose to continue, the following notice will show: 

This confirms which drives you have selected to create the new master disk, and how many files 
have been found to copy. Click on OK, and the screen will switch to look something like this:
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8:  CTN Master Disk Builder

Once all the disk drives have been built, the following notice will show: 

You can now remove the USB memory sticks, and check them prior to duplication.

CTN & FTN Operating Manual 24



8:  CTN Master Disk Builder
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Start
Open CTN Master Disk Builder

Check News and Magazine folders are in 
correct order and enabled

Select correct publication using the drop-
down list

Add/Enable any extra folders needed

Select drives to copy to (Select All)

Insert USB memory sticks in computer

Click Build

Remove Disks and Duplicate
Once build process completes
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